Cours d’outils informatique
Chapter 1: Discovering the operating system 
Course 1: General information about Windows (Operating system) 
1.Definition of an operating system: is a set of programs which makes the connection between the hardware of a machine and the user's applications. So this is the interface between the user and the machine. Examples: MS-DOS, Windows, UNIX, LINUX…etc. The most used operating system today is Windows. 
2. Windows environment 
2.1. The office As soon as your computer is turned on and the operating system is loaded, you see a number of graphical objects on your screen. In Windows, this first screen is called the Desktop. This term actually refers to the Windows screen, that is to say both the background of the screen and the various objects found there, essentially icons and the taskbar.[image: ]
Figure 1.Le bureau.
2.2.Icons: are small graphics representing certain objects (programs, files), or constituting shortcuts to them. Essentially, an icon and a shortcut work the same way, when it comes to launching the program and opening the corresponding file. An item's icon represents the item itself, while a shortcut simply indicates where the item is located. A shortcut can be identified by the small arrow placed in its lower left corner.


[image: ]



[image: ]Figure 2.Raccourci




Figure 3. Icône
2.3. Taskbar :The taskbar allows you to control the tasks that your computer performs. By default, it has only one line and is located at the bottom of the screen.
[image: ]
Figure 4.Barre des taches
This bar has several elements: -The Start menu access button -The task area -The notification area 2.3.1.Start Menu The Start menu contains commands for accessing all Windows features. On first startup, the Start menu opens automatically. Afterwards, all it takes is one click on the start button.
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Figure 5. Le Menu Démarrer
The Start menu is made up of four main areas: The Header: a bar containing the name of the connected user. Clicking on the user icon provides direct access to user accounts. - On the left, a vertical area containing the list of recently used programs. As well as access to Internet Explorer and Outlook Express. At the bottom of this area, the All Programs button opens the menu for selecting all Windows utility programs and accessories. This menu in turn allows you to launch certain programs, and to open submenus containing other programs. - On the right, a vertical area contains access icons to basic Windows functionalities, as well as certain folders specific to each user. - In the lower part, a bar contains the close session buttons; and Shut down the computer. 2.3.2.The task area The task area is in the central part of the taskbar. It is intended to contain buttons representing the active programs, and allowing you to simply switch from one to the other.[image: ]
Figure 6.Zone des tâches
2.3.3.The notification area The notification area, located at the far right of the taskbar, contains icons representing system functions and allowing you to consult their details.
[image: ]  [image: ]
Figure 7.Zone de notification 
2.4. Explore Windows To explore Windows and get an idea of its contents: - Open the Start menu, then click My Computer. A new window opens.[image: ]
Figure 8.Fenêtre de poste de travail.
The main window is divided into two parts called "panes". The right pane contains My Computer objects, while the left pane, on a blue background, displays different icons and commands, grouped by theme, and corresponding to the usual tasks (System Management, Other Locations and Details). In addition, two bars are located below the menu bar: these are toolbars
.
The toolbar: Below the menu bar, there is a bar of the same color, which contains several icons.[image: ]
Figure 9.Barre d’outils

2.5. Exit Windows - Click the Start button. The Start menu opens; - Click the Shut down computer button. Windows displays the desktop in gray, then a Shut down computer dialog box. The Sleep button places the computer in a reduced power state so that it can be restarted quickly. The Stop button ends any programs that may be running, then shuts down the computer. The Restart button ends any programs that may be running, then restarts the computer. The Cancel button allows you to cancel the shutdown operation, and therefore continue to use Windows.
[image: ]






Figure 10.Arrêter l’ordinateur

















Chapter 2: discovery of the IT suite Course
2: Design documents in Word Entering text 
1-Open your Word file


2- Start typing your text (enter a number, letter or words) using the keyboard
[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\calvier.jpg]






[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\01.GIF]Le menu accueil vous permettra de :
· Changer le type d’écriture (Case :times new roman) 
[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\,,,.GIF][image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\AA.GIF]
· Changer la taille d’écriture (Case :12                ou AA               )
[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\Ae.GIF][image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\GI.GIF]
· [image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\A.GIF]Changer la forme d’écriture (Case :G,I )                  , Aa :Magiscule ou Minuscule
             A : couleur d’écriture
· [image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\souligner.GIF]Souligner votre écriture (Case :S) 
· Changer la couleur du paragraphe (Case :Ab ) [image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\color.GIF]
· Justifier votre écriture (aligner le texte à gauche ,à droite ,centré ,justifié).
[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\justifier.GIF]

· Changer l’interligne (espacement entre les  lignes)
[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\inte'rligne.GIF]

· [image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\numeroter.GIF]Numéroter et organiser vos lignes.


· [image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\02.GIF]Copier et coller  de vos paragraphes



· Rechercher, remplacer ou sélectionner un mot ou une phrase
[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\rechercher.GIF]



· [image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\style.GIF]Modifier  les styles d écriture




Le menu insertion vous permettra de :
· [image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\tabl.GIF]Insérer un tableau




· [image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\illu.GIF]Insérer des : images, images clipart,formes,smart art ,graphiques



· Insérer une zone de texte ,word art ,lettrine, date et l’ heure ,lignes de signature etc
[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\one de texte.GIF]


· [image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\equation.GIF]Insérer des : équations, symboles



· [image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\entetes.GIF]Insérer un entête et pied de page, et numéroter les  pages  de votre document





the home menu will allow you to: 
• Change the type of writing (Case: times new roman)
 • Change the writing size (Case: 12 or AA)
 • Change the form of writing (Case:G,I), Aa:Magiscule or Lowercase A: writing color • Underline your writing (Box:S) 
• Change the color of the paragraph (Case:Ab) 
• Justify your writing (align the text to the left, right, center, justified).
 • Change line spacing (spacing between lines)
 • Number and organize your lines.
 • Copy and paste your paragraphs
 • Find, replace or select a word or phrase 
• Change writing styles The insert menu will allow you to: • Insert a table 
• Insert: images, clip art, shapes, smart art, graphics
 • Insert a text box, word art, drop cap, date and time, signature lines etc.
 • Insert: equations, symbols
 • Insert a header and footer, and number the pages of your document

The layout menu
 
[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\menu mise en page.GIF]




· It will allow you 
· to: • Change the orientation, number of columns, line numbering of your text. 
• Change the margin, size, color, borders of your page 
        • Define hyphenation, page breaks 
• Add watermarks 
• Improve the general appearance of a page or an entire document by applying a theme, a background color
 • Set indentation and spacing between paragraphs of your text
 • Align the paragraphs of your text

The references menu

[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\menu references.GIF]



It will allow you to: 
• Allows you to create professional documents with organized sections, tables of contents or an index.
 • Manage sources, citations and a bibliography.
 • If you have inserted images, take advantage of the features of the illustrations and captions table to manage these images efficiently. 
• Also add page and endnotes

The direct mail menu



[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\publipostage.GIF]



With the “Mail Merge” tab, you efficiently create your documents, labels and envelopes by merging them with a data source, such as an address book or database.
The revision menu

[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\revision.GIF]





• It features grammar and spelling control, as well as numerous search functions. 
• Allows you to view edits and processing of reviewer marks.
 • Allows you to compare different versions of a document and combine them into a final version.
The display menu


[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\Cours\COURS HABILITATION\COURS INFORMATIQUE APPLIQUEE  3EME ANNEE PV\afficahge.GIF]




The “Display” tab • Includes the five main display modes, as well as ruler, grid, document explorer and thumbnails. • Allows you to display several open documents simultaneously • Allows you to switch between different windows or display them on the same screen.


Course 3: Design tables with Excel
1. The Excel environment 1.1. Definition: Excel is collection and processing software designed by the company Microsoft and allowing the calculation, synthesis and analysis of numerical or textual data. 1.2. Launching Excel (Load, Save a spreadsheet) 
1.2.1. Load an Excel spreadsheet There are several possibilities to launch Excel  Using the button located on the desktop: double-click on the shortcut located on the desktop.  Through the Windows Start menu: 1- Click on the Start menu 2- Choose All programs 3-Select Microsoft Office 20074-Puis Microsoft Office Excel 2007.
[image: C:\Users\pc\Desktop\HHHH.GIF]










Figure 11.Possibilités pour lancer l’Excel

1.2.2. Save an Excel spreadsheet 
1-click on the office button 
2-click save 
1.3. The Excel screen Once Excel is launched, you will get the following screen which includes: • Title bar • ribbon with tabs • the quick access toolbar: it can be displayed either under the ribbon or on the ribbon. • Formula bar • Display area for the reference or name of the active cell • Active cell • Column headers + Row headers • Worksheet tabs • Scroll bar for moving horizontally and vertically + Scroll bar for viewing spreadsheets • Status bar[image: C:\Users\pc\Desktop\nknnknk.GIF]
Figure 12.L’écran Excel
1.3.1.The title bar Includes: • The name of the folder • The name of the application (Microsoft Excel) • Close window • Decrease window size at lower level • Minimize window • Office button:  It provides access to recent documents and includes basic commands that allow you to open, save and print your file.  Also includes Excel Options that allow you to change Excel settings.

[image: C:\Users\pc\Desktop\COURS SKIKDA\3.GIF]




Figure 13.La barre de titre.
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Figure 14.Le bouton office
1.3.2.the ribbon with tabs: for the different menus. 
The ribbon tabs are: 1.3.2.1.The Home tab: access to the management of formatting, font and styles

[image: C:\Users\pc\Desktop\COURS SKIKDA\01.GIF]



Figure 15. L’onglet Accueil
1.3.2.2.The Insertion tab: insertion of table, image, line, column, header and footer, etc.
[image: C:\Users\pc\Desktop\COURS SKIKDA\2.GIF]






Figure 16. L’onglet Insertion
1.3.2.3.The Layout tab: management of the document layout

[image: C:\Users\pc\Desktop\COURS SKIKDA\03.GIF]
Figure 17. L’onglet Mise en page

1.3.2.4.The Formulas tab: creation of calculation formulas.


[image: C:\Users\pc\Desktop\COURS SKIKDA\04.GIF]
Figure 18. L’onglet Formules


1.3.2.5.The Data tab: management and import of data, sorting, filters, etc.[image: C:\Users\pc\Desktop\COURS SKIKDA\05.GIF]
Figure 19. L’onglet Données


1.3.2.6.The Revision tab: revision of the document, spelling, comments, protection.


[image: C:\Users\pc\Desktop\COURS SKIKDA\06.GIF]
Figure 20. L’onglet Révision

1.3.2.7.The Display tab: management of the display, windows and panes.

[image: C:\Users\pc\Desktop\COURS SKIKDA\07.GIF]
Figure 21. L’onglet Affichage
1.3.2.8.Additional tabs: There are additional tabs to manage elements that can be inserted into workbooks such as images, diagrams, graphs, tables 
1.3.3.The Quick Access toolbar • It provides quick access to the different functions of the spreadsheet. • The function of each button is displayed in a tooltip when hovered over it with the mouse. • This toolbar can be displayed above or below the ribbon and can be customized using the right click.


[image: C:\Users\pc\Desktop\COURS SKIKDA\4.GIF]






Figure 22. La barre d' outils Accès rapide

1.3.4.Formula bar: allows you to perform operations (calculation) on the data contained in the cells.


[image: C:\Users\pc\Desktop\COURS SKIKDA\1111.GIF]



Figure 23. Barre de formule 

1.3.5.Display area for the reference or name of the active cell 
[image: C:\Users\pc\Desktop\COURS SKIKDA\111.GIF]1.3.6.Active cell The cell is a box on the worksheet. It contains data (text, number, calculation formula, etc.) and a format (Font characters, color, etc.). The intersection between a row and a column constitutes a cell. A cell is identified by its reference. The reference is made up of the column title and the line number. Example: Cell A1 _ Column A _ Row 1. Here is a cell:	




Figure 24. Cellule active
1.3.7. Column Headers + Row Headers 
1.3.8.Spreadsheet tabs

[image: ]
Figure 25. Onglets des feuilles de calcul

1.3.9.Scroll bar to move horizontally and vertically: for displaying spreadsheets

[image: C:\Users\pc\Desktop\COURS SKIKDA\gggg.GIF]





Figure 26. Barres de défilement



1.3.10. Status bar It's located at the bottom of the spreadsheet, just above the taskbar. It may contain nothing. It is fully configurable.
[image: C:\Users\pc\Desktop\COURS SKIKDA\kkkk.GIF]







Figure 27. Barre d’état

2. Manipulation D’Excel
2. 1.Analyse et Gestion de données
2. 1.1.Types de données : chiffres+lettres ou mots
2. 1.2.Saisie de données :
1-Ouvrir votre  fichier Excel
2-Cliquer 2 fois sur la cellule 
3-Entrer  un chiffre, lettre ou mot
2. 1.3.Copier des données :
1- Sélectionner les blocs contenant les données que vous copier
2-Clique droit par votre souris.
3-copier
4-coller
2. 1.4.Déplacement des données :
1- Sélectionner les cellules contenant les données que vous voulez déplacer
2-Clique droit par votre souris.
3-Couper
4-Coller
2. 1.5.Supprimer les données :
1- Sélectionner les cellules contenant les données que vous voulez supprimer.
2-Cliquer droit par votre souris.
3-Supprimer.
2. 1.6.Utilisation des formules de calcul :
1-Taper = dans la cellule où vous voulez avoir le résultat.
2-Cliquer sur fx
3-Entrer votre formule
4-Sélectionner les données puis cliquer sur OK
2. 1.7.Mise en forme d’une feuille de calcul :
1- Sélectionner les cellules contenant les données que vous voulez  changer la forme
2- Dans le menu accueil cliquer sur : 
Times new roman= pour changer le type d’écriture
12 : pour changer la taille d’écriture
G,I : pour changer la forme d’écriture
S : pour souligner votre écriture
Aa : pour changer la forme d’écriture en Magiscule ou Minuscule
Ab : pour changer la couleur des cellules
A : pour changer la couleur d’écriture
2. 1.8.Triage des données :
[image: C:\Users\pc\Desktop\triage.GIF]1- Sélectionner les cellules contenant les données que vous voulez  trier
2-Dans le menu accueil cliquer sur le  bouton de triage 
2. 1.9.Format de cellules :
1-Sélectionnez une ou plusieurs cellules, faites un clic droit sur votre sélection et choisissez « Format de cellule ».
2- Personnaliser l'affichage et la mise en forme de vos cellules par la fenêtre format de cellule.
· Pour obtenir un nombre avec des décimales fixes, choisissez « Nombre » et définissez le nombre de décimales
· Pour ajouter le symbole monétaire, choisissez « Monétaire » ou « Comptabilité » 
· Si la cellule contient une date, vous pouvez formater cette date Depuis « Date ».
· Vous pouvez également modifier l’affichage des heures, des nombres (pourcentage, fraction, scientifique) depuis cet onglet.
· Vous pouvez modifier l’alignement vertical/horizontal du texte, son orientation, activer le renvoi automatique à la ligne si nécessaire (pour le texte qui dépasse de la cellule),
· L’onglet « police »permet de personnaliser le texte .
· Les onglets « bordures » et « remplissage permettent d'ajouter des bordures ainsi qu'une couleur/un motif en fond de cellule. 
2. 1.10.Impression des données
1-Sélectionner votre  fichier
2-Clique droit par votre souris.
3-Imprimer
2. 2.Blocs de données :
2. 2.1.Désignation du bloc:
1-Sélectionner le bloc par votre souris
2. 2.2.Copie d’un bloc :
1- Sélectionner les blocs contenant les données que vous copier
2-Clique droit par votre souris.
3-copier
4-coller
2. 2.3.Déplacement de bloc:
1- Sélectionner les cellules contenant les données que vous voulez déplacer
2-Clique droit par votre souris.
3- Couper
4-Coller
2. 2.4.Suppression ou effacement de bloc :
1-Sélectionner les blocs contenant les données que vous supprimer.
2-Clique droit par votre souris.
3-Supprimer.
2. 2.5.Format lignes et colonnes :
1-Sélectionner les colonnes  à modifier.
2- Sélectionner format
2-Changer la hauteur de ligne  et la largeur de colonnes
2.3.Le graphisme Excel :
2.3.1. Création  et visualisation d’un graphique
1- Sélectionner votre tableau ou données
2- Cliquer sur le menu insertion
3- Sélectionner votre type de graphiques
2.3.2. Mise en forme et modification d’un graphique
-Pour changer le type de graphique, cliquez sur « Modifier le type de graphique » dans l'onglet création et choisissez un nouveau type puis cliquer OK.
-Vous pouvez également choisir une des dispositions de graphique ou  un des styles  prédéfinies.
-A partir de l’onglet:dispositions, vous pouvez ajouter/retirer/personnaliser les éléments suivants : titres, légendes, étiquettes, table de données, axe, quadrillage, zone de traçage, barre d’erreures, formes, image, zone de texte.
-A partir de l’onglet: mise en forme vous pouvez changer le remplissage, le contour, l’hauteur, la largeur et les effets de forme.
2.4. Import - Export de fichiers avec d’autres logiciels
1-Lancer l’Excel.
2-Cliquer sur le bouton office.
3-Cliquer sur ouvrir.
4-Cliquer sur tous les fichiers.
5-Suivre les étapes d’importation (assistant d’importation de texte) .
6- Enfin, cliquer sur terminer.
2.5. Rechercher des enregistrements
1-Cliquer sur le menu démarrer
2- Dans la case : rechercher des programmes ou fichiers taper : xls ou le nom du classeur

2. Handling Excel
 2. 1.Analysis and Data Management 
2. 1.1. Data types: numbers+letters or words 
2. 1.2.Data entry: 1-Open your Excel file 2-Click twice on the cell 3-Enter a number, letter or word 2. 1.3.Copy data: 1- Select the blocks containing the data you are copying 2-Right click with your mouse. 3-copy 4-paste 
2. 1.4. Data movement: 1- Select the cells containing the data you want to move 2-Right click with your mouse. 3-Cut 4-Paste 2. 1.5.Delete data: 1- Select the cells containing the data you want to delete. 2-Right click with your mouse. 3-Delete. 2. 1.6.Use of calculation formulas: 1-Type = in the cell where you want to have the result. 2-Click on fx 3-Enter your formula 4-Select the data then click OK 2. 1.7.Formatting a spreadsheet: 1- Select the cells containing the data you want to change the shape 2- In the home menu click on: Times new roman= to change the type of writing 12: to change the writing size G,I: to change the form of writing S: to highlight your writing Aa: to change the writing form to Magiscule or Lowercase Ab: to change the color of the cells A: to change the writing color 2. 1.8. Data sorting: 1- Select the cells containing the data you want to sort 2-In the home menu click on the sort button 2. 1.9.Cell format: 1-Select one or more cells, right-click on your selection and choose “Format Cells”. 2- Customize the display and formatting of your cells using the cell format window.  To get a number with fixed decimal places, choose “Number” and set the number of decimal places  To add the currency symbol, choose “Currency” or “Accounting”  If the cell contains a date, you can format that date From “Date”.  You can also modify the display of times, numbers (percentage, fraction, scientific) from this tab.  You can change the vertical/horizontal alignment of the text, its orientation, activate word wrapping if necessary (for text that extends beyond the cell),  The “font” tab allows you to personalize the text.  The “borders” and “fill” tabs allow you to add borders as well as a color/pattern at the cell background. 2. 1.10.Printing data 1-Select your file 2-Right click with your mouse. 3-Print 2. 2.Data blocks: 2. 2.1.Block designation: 1-Select the block with your mouse 2. 2.2.Copying a block: 1- Select the blocks containing the data you are copying 2-Right click with your mouse. 3-copy 4-paste 2. 2.3. Block movement: 1- Select the cells containing the data you want to move 2-Right click with your mouse. 3- Cut 4-Paste 2. 2.4. Block deletion or erasure: 1-Select the blocks containing the data you want to delete. 2-Right click with your mouse. 3-Delete. 2. 2.5. Row and column format: 1-Select the columns to modify. 2- Select format 2-Change row height and column width 2.3.Excel graphics: 2.3.1. Creating and viewing a chart 1- Select your table or data 2- Click on the insert menu 3- Select your type of graphics 2.3.2. Formatting and editing a chart -To change the chart type, click on “Change chart type” in the design tab and choose a new type then click OK. -You can also choose one of the predefined chart layouts or styles. -From the tab: layouts, you can add/remove/customize the following elements: titles, legends, labels, data table, axis, grid, plot area, error bar, shapes, image, text area. -From the tab: formatting you can change the fill, outline, height, width and shape effects. 2.4. Import - Export files with other software 1-Launch Excel. 2-Click on the office button. 3-Click on open. 4-Click on all files. 5-Follow the import steps (text import wizard). 6- Finally, click on finish. 2.5. Search recordings 1-Click on the start menu 2- In the box: search for programs or files type: xls or the name of the folder



Cours 4 : Conception d’une présentation avec power point
-Avec PowerPoint, on crée des présentations, destinées à être présentés à un public.
-Une suite de diapositives s’appelle une présentation qui est destinée à être présenté à un public (diaporama).
Fenêtre principale
Une fois power point est  lancé, vous obtenez l’écran suivant qui comprend :
Course 4: Designing a presentation with Power Point -With PowerPoint, we create presentations, intended to be presented to an audience. -A series of slides is called a presentation which is intended to be presented to an audience (slideshow). Main window Once Power Point is launched, you get the following screen which includes:
1-L’onglet Accueil : 
1-The Home tab
[image: ]



Servez-vous de l’onglet « Accueil » pour : 
-Modifier les polices, les paragraphes ou les styles des parties sélectionnées. 
-Copier et coller des données sélectionnées et depuis le Presse-papiers et de reproduire des formats d’une sélection à une autre. 
 -Ajouter une nouvelle diapositive, de modifier sa disposition, de réinitialiser une disposition et de supprimer des diapositives. 

Use the “Home” tab to: -Change fonts, paragraphs or styles of selected parts. -Copy and paste selected data to and from the Clipboard and reproduce formats from one selection to another. -Add a new slide, change its layout, reset a layout and delete slides.
2- L’onglet Insertion
2- The Insertion tab

[image: ]
Servez-vous de l’onglet  « Insertion », pour : 
-Générez des présentations d’aspect professionnel en insérant des images, des cliparts, des formes, des composants SmartArt, tableaux et des graphiques.
-Présentez efficacement vos données avec les différents types de graphiques. 
-Insérer des zones de texte, des en-têtes et des pieds de page, du texte WordArt, des symboles, des informations relatives et d’autres objets.
Use the “Insert” tab to: -Generate professional-looking presentations by inserting images, clipart, shapes, SmartArt components, tables and charts. -Present your data effectively with the different types of graphs. -Insert text boxes, headers and footers, WordArt text, symbols, related information and other objects.

4- L’onglet Création
3- The Creation tab

[image: ]


Servez-vous de l’onglet  « Insertion », pour : 
-Employez, créez, concevez et enregistrez des thèmes qui améliorent l’aspect de vos diapositives.
-coordonnez des couleurs, des polices et des effets qui facilitent la mise en forme de tout ou partie de la présentation.
-créer des arrière-plans pour les diapositives sélectionnées, à savoir des images, des schémas ou des dégradés de couleurs.
Use the “Insert” tab to: -Use, create, design and save themes that enhance the look of your slides. -coordinate colors, fonts and effects that make it easy to format all or part of the presentation. -create backgrounds for selected slides, i.e. images, diagrams or color gradients.
4- L’onglet Animation
The Animation tab
[image: ]
Servez-vous de l’onglet  «Animation», pour : 
-Créez et pré visualisez des minutages applicables à une ou plusieurs diapositives. 
-Sélectionner et appliquer un jeu d’effets de transition prédéfini qui crée un mouvement entre les diapositives lors de la présentation.
 -Définissez la vitesse et la durée des animations et des transitions et vous les pré visualisez dans l’onglet « Animations ». 
-Vous déterminez en outre la manière de changer tout ou une partie d’une diapositive 
Use the “Animation” tab to: -Create and preview timings applicable to one or more slides. -Select and apply a set of predefined transition effects that create movement between slides during the presentation. -Define the speed and duration of animations and transitions and preview them in the “Animations” tab. -You also determine how to change all or part of a slide

5- L’onglet Diaporama
[image: ]
Servez-vous de l’onglet  «Diaporama», pour : 
-Déterminer comment afficher ou prévualiser votre présentation en lecture plein écran sur un moniteur ou via un projecteur.
-Définir la résolution du diaporama pour l’ajuster à l’écran, enregistrer le texte d’accompagnement, répéter l’animation et les minutages 
-Choisir de masquer ou d’afficher certaines diapositives pendant le diaporama. 
-Créez également un diaporama personnalisé ou définissez un groupe de diapositives de la présentation en cours à afficher dans un ordre différent. 

Use the “Slideshow” tab to: -Determine how to display or preview your presentation in full-screen playback on a monitor or via a projector. -Set slideshow resolution to fit the screen, record accompanying text, repeat animation and timings -Choose to hide or show certain slides during the slideshow. -Also create a custom slideshow or set a group of slides from the current presentation to display in a different order.




6- L’onglet Révision
6- The Review tab

[image: ]
l’onglet  «Révision» : 
-Regroupe les commandes de vérification orthographique et grammaticale, des fonctions de recherche et de traduction et le dictionnaire des synonymes. 
-Accueille également les commandes de révisions par différents relecteurs, la protection et le partage de la présentation, ainsi que le suivi des modifications dans le cadre de la collaboration et de la finalisation de la présentation.
the “Review” tab: -Combines spelling and grammar check commands, search and translation functions and the thesaurus. -Also welcomes orders for revisions by different reviewers, protecting and sharing the presentation, and tracking changes as part of the collaboration and finalization of the presentation.
7- L’onglet Affichage

7- The Display tab
[image: ]
Dans l’onglet « Affichage »vous :
-Choisissez l’affichage de la présentation, décidez de masquer ou d’afficher la règle et le quadrillage et -Modifiez les facteurs de zoom pour ajuster la présentation à la fenêtre. 
-Afficher plusieurs présentations ouvertes simultanément
-Naviguez d’une fenêtre à l’autre ou affichez-les sur le même écran. 
évolutive entre les différentes espèces végétaux que vous êtes en train d'étudier
In the “Display” tab you: -Choose the presentation display, decide to hide or show the ruler and grid and -Change the zoom factors to fit the presentation to the window. -View multiple open presentations simultaneously -Navigate between windows or view them on the same screen. evolution between the different plant species that you are studying



Chapitre 3:Les logiciels et l’algorithmique
Définition d'un logiciel: est un programme informatique conçu pour faire fonctionner un ordinateur et des applications. 
Définition de l’algorithmique ou l’algorithme : Un algorithme est une suite ordonnée d'instructions qui indique la démarche à suivre pour résoudre une série de problèmes équivalents. 
Utilisation de l'algorithmique en biologie :
1. Résoudre des problèmes d'optimisation
2. Savoir quel est le degré de parenté et l'histoire
Chapter 3:Software and algorithms 
Software Definition: is a computer program designed to operate a computer and applications. Definition of algorithmic or algorithm: 
An algorithm is an ordered sequence of instructions which indicates the procedure to follow to solve a series of equivalent problems. Use of algorithms in biology: 1. Solve optimization problems 2. Know the degree of relationship and history





Chapitre 4: Introduction à Latex
1. Comment écrire au latex ?
1-télécharger et  installer une bibliothèque miktex+éditeur latex texmaker (version convenable a votre système).
2-cliquer sur  l’icone nouveau fichier  ou bien  l’onglet fichier+nouveau fichier
3-enregistrer le fichier (l’onglet fichier+nouveau fichier+enregistrer sous)

Chapter 4: Introduction to Latex 
1. How to write in latex? 
1-download and install a miktex library + texmaker latex editor (version suitable for your system). 
2-click on the new file icon or the file+new file tab 
3-save the file (file tab+new file+save as) 4- to start writing you do:






4- pour commencer à écrire  vous faites
\ document class{ .} (entrer le type de document :article ,book entre les accolades)
\use package [ utf8] {inputenc} (pour écrire  à n’importe quelle langue)
\use package [T1] {fontenc}(pour écrire  à n’importe quelle langue)
\title{ .} (entrer le titre du document entre les accolades)
\author{ .} (entrer le nom de l’auteur entre les accolades)
\date{ .}  (entrer  la date entre les accolades)
\begin{ document}, end{ document} s’affichera automatiquement
Entre\begin{ document} et \end{ document}  écrit votre texte.
\make title{ .}  (génération du titre pour que le titre soit visible après compilation)
\section{ .} (entrer le nom de la section)
Entre le texte  de la section
\\ pour revenir  à la ligne.
\subsection{ .} (entrer le nom de la sous section)
Entre le  texte de la sous section
\\ pour revenir  à la ligne.
\section { conclusion}
Entrer le texte du conclusion
Enregistrer et  compiler ( outils (tool) +compilation rapide (quik build)ou tapper F1)
2. Mise en forme du texte
\textit{ } (entrer le texte qui sera en italique)
\textbf{ }(entrer le texte qui sera en gras)
\underline{ }(entrer le texte qui sera souligné)
\center(entrer le texte qui sera centré)
\flushright(entrer le texte qui sera aligné  à droite)
\flushleft(entrer le texte qui sera aligné  à gauche)
\\ retour à la ligne
\ newpage (pour insérer une nouvelle page)	
\hspace*{ } (pour insérer un espace horizontal+taille d’espace entre accolades)	
\vspace*{ }(pour insérer un espace vertical +taille d’espace entre les accolades)	
\tiny{ }(pour insérer un texte en miniscule entre  les accolades)
\scriptsize{ }(pour insérer un texte très petit entre  les accolades)
\footnotesize{ }(pour insérer un texte assez petit entre  les accolades)
\small{ }(pour insérer un texte  petit entre  les accolades)
\normalsize{ }(pour insérer un texte normal  entre  les accolades)
\large{ }(pour insérer un texte grand entre  les accolades)
\Large{ }(pour insérer un texte plus grand entre  les accolades)
\LARGE{ }(pour insérer un texte  très grand  entre  les accolades)
\huge{ }(pour insérer un texte énorme entre  les accolades)
\Huge{ }(pour insérer un texte géant entre  les accolades)
\fbox{ }(pour encadrer le texte (une seule ligne) entre  les accolades)
Pour encadrer le texte avec plusieurs lignes
\fbox{
\begin{minipage}{4cm}	
Première ligne\\
Deuxième ligne\\
\end {minipage}
\ shadowbox{ }( (pour insérer un texte ombré (une seule ligne) entre  les accolades)
\doublebox{ }( (pour insérer un texte doublement encadré (une seule ligne) entre  les accolades)
\ovalbox{ }( (pour insérer un texte dans  un cadre à coins arrondies (une seule ligne) entre  les accolades)
3.Comment insérer une ligne ?
\line (cordonnées du vecteur directeur de la ligne) {largeur de la ligne }
1,0 : Ligne  horizontale
0,1 : Ligne verticale
1,1 : Ligne inclinée vers la droite
-1,1 : Ligne inclinée vers la  gauche
4.Comment insérer une liste ?
4.1. Une liste normale
\begin{itemize}
\item (le premier élément)
\item (le deuxième élément)
\item (le troisième élément)
\end{itemize}
\end{document }
4.2. Une liste numérotée
\begin{enumerate }
\item (le premier élément)
\item (le deuxième élément)
\item (le troisième élément)
\end{ enumerate }
\end{document }
4. 3. Une liste numérotée avec des descriptions
\begin{description}
\item{le premier élément : } description
\item {le deuxième élément: }  description
\item {le troisième élément: }  description
\end {description }
\end{document }
5. les colonnes en latex
5.1.document à 2 colonnes
\ document class{ twocolumn} 
\begin{ document }
Texte
\end{document }
5.2.document à  plusieurs colonnes  
\begin{multicol }{ nombre de colonnes souhaitées}
Texte
\end{multicol }
\end{document }
6. les tableaux en latex
\begin{tabular }{ nombre de colonnes souhaitées,séparées  par des traits   }
[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\contenu centré.GIF]	: centré
[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\contenu aligné gauche.GIF]
	: aligné à gauche
[image: C:\Users\pc\Desktop\DOSSIER HABILITATION\contenu aligné droite.GIF]
	: aligné a droite 
\hline
Colonne1& Colonne2 &Colonne3\\
\hline
Colonne3& Colonne4 &Colonne5\\
\hline
\end{ tabular }
\end{document }
7. Utiliser une couleur  à latex
\use package {color}
\pagecolor{}(couleur de la page entre les accolades)
\textcolor{}(couleur du texte entre les accolades)
\ colorbox {}(couleur de la boite entre les accolades)
8. mise en page  dans latex
8.1. Personnaliser les  marges de la page
\use package {left = ..cm,right=..cm,top=..cm,bottom= ..cm }{geometry}
Ou bien utiliser l’assistant nouveau document
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